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Wiederverwendungsbibliothek (Resuse Library)

O-Ring mit Abzugskorper, halbautomatische Platzierung

Aufgabenstellung:

Es soll aus der Wiederverwendungsbibliothek (Reused Library) ein O-Ring eingefiigt werden der seinen Abzugskorper
(Nut) mitbringt. Beim Platzieren soll lediglich die ,Landeflache” und die Position gefragt werden, d.h. die verwendeten

Verkniipfungsbedingungen (Mating Conditions) sind bereits vordefiniert, das reduziert die Angaben (Anzahl der
Klicks) zur Verknupfung um die Halfte!

Komponente ,0-Ring_mit_Abzugskoerper*

© 1999 - 2018 HBB Engineering GmbH - All rights reserved



Zunachst werde zwei Parameter in den Ausdriicken (Expressions) festgelegt, die anschlie3end in einer Skizze

zugewiesen werden:

DOring = Querschnitts-Durchmesser des O-Rings
Ri = Ringdurchmesser
p7=Ri

Y

_p14=DOring+DOring/3

Danach wird in einer zweiten Skizze die O-Ring-Nut definiert.

o
o

=DOrin

5

pl
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Die beiden Skizzen werden zu Korpern rotiert.

Die Nut, die spater den
Abzugskorper definiert, wird
einem neuen Reference Set
,TASCHE" zugewiesen.

Der O-Ring wird automatisch
beim Speichern dem Ref. Set
Modell(,MODEL") zugewiesen
(Einstellung in den
Anwenderstandards (Customer
Defaults)). Achtung! Diese
Zuordnungen sind nach
Anderungen ggf. zu kontrollieren!

Reference Sets im aktiven Teil

Meues Reference Set hinzufiigen

Modell ("MODEL")
Ganzes Teil
Leer

TASCH

Wichtig ist nun, dass in den
Anwenderstandards der
Ref. Set fur
Abzugskorper auch als
,TASCHE" (oder so)

£} Anwenderstandards »

definiert wird (ggf den Standardstufe | Benutzer - Entsperrt = Einheitensystem | Metrisch + ﬂ? -
Systembetreuer
fragen). Hier hatten Gat:\:ay _ o UDF-Bibliothek Symbolbibliothek 2D-Schnitt-Bibliothek
wir Probleme mit der Obge;tnem Indexsuche 2D-Komponentenbibliothek PTS-Vorlage
T €
ubl |c.hen Benutzerattribute Allgemein Klassifizierung Wiederverwendbare Komponente
Vfo'ielr!ﬁte"ung Benutzercberfliche Befestigungsbaugruppe Wiederverwendbare Tasche
mialse / Visualisierung =
Facette - Einstellungen Reference Set @
Referengé Set Hervorhebung - Einstellungen TASCHE
fals o
/
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{3} Reference Sets O X
M

Einfiigen >
Konstruktionsform-
element >
Rotationskérper

Insert > Design
Feature > Revolve

Datei >
Dienstprogramme >
Anwenderstandards
> Gateway >
Wiederverwendung
sbibliothek >
Wiederverwendbare
Tasche

File > Utility >
Customer Defaults
> Gateway > Reuse
Library > Reusable
Pocket



Der O-Ring soll in der Wiederverwendungsbibliothek (Reused Library) in

,Beispiele HBB*“ angeboten werden. Wie derartige Bibliotheksstrukturen =~ [O0 Wiederverwendungsbibliothek o
angelegt werden finden Sie in einem anderen HBB-Merkblatt oder etwa Mame
in unserem Buch ,NX Systembetreuer NX10/NX11“. Naturlich wird es +-[ %! Reusable Object Library (Example Only) fy
auch in der NX-Onlinehilfe beschrieben. S0 s T W Fo
Bei uns muss der O-Ring hier abgelegt werden: 5 Fastener Assembly Configuration Library 5:.
9 geleg : + ) SPLM_INSTALLATION '
C:\NX_Share\NX11\ReuseLibrary\Beispiele_HBB +ff SPLM Beispicle -
+ [l SPLM_PTS_Beispiele
. Zusétzlich zum NX-Part benétigen wir - fff§ HBB_REUSE o

S noch drei weitere Dateien, die in etwa [ Beispicle HBE

2 O-Ring.bmp den gleichen Namen, wie das Part +- {8l UDF-Bibliothek

5] O-Ring_mit Abzugskoerper.krx haben sollten, jedoch eine andere +{fffl Benutzerdefinierte Symbolbibliothek 6\\

o _ Extension aufweisen. +-1r Favoriten
2| O-Ring_mit_Abzugskoerper.prt

B O-Ring_mit_Abzugskoerperxls

Die krx-Datei kann entweder mit einem Editor erstellt/abgeandert werden, oder sie kann auch im NX-Dialog erstellt und
geandert werden. Hier drinnen finden sich die ,Verdrahtungen® zur PRT-, zur Excel- und zur BMP-Datei.

<?xm] version="1.0" encoding="UTF-8"7>

<KnowledgeReuse>
<ItemData>
<Part Lucatiun=1G—Rinq_mit_Abzuqskuerper.prtbf}
<KeyParameter DescriptiveName= R1 =R1</KeyParamerer:
<DataFile Lucatinn=“..f..f..f..fNX_SharefollfReuseLibraryfaei5pﬁe1e_HBBfG—Riﬂq_mit_Abzuqskuerper.x151f}

<DetailImage Lucatiuﬂ=”..f..f..f..fo_SharefollfREUSELibraryﬁaeiapie1e_HEB[G—R1ng.bmprf>
=/ITemData>

=/Knowl edgeReuse>
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Einfacher ist es, die krx-Datei aus NX heraus anzupassen.
Dazu wahlt man in der Wiederverwendungsbibliothek den
O-Ring (das Element) mit der <MT3> an und geht auf KRX-Datei bearbeiten (Edit KRX File).

- - HBB_REUSE

- ﬁ EE_ISP_IElE_HEE
+ﬁ LIDF-Bibliothek

+ﬁ Benutzerdefinierte Symbolbibliothek

+-%'7 Favoriten

Hier werden die ,Verdrahtungen® zur
Excel-Datei und ggf. zu einem BMP-
Vorschaubild festgelegt und die
Parameter, die dem Benutzer zur
Anderung angeboten werden sollen.

i | 1]

| » Nach Anderungen empfiehlt es sich,

Suchen

Elementauswahl

1-2von2

o Offnen
o Schnitt
EE Kopieren

Hilfsdatei

Al KRX-Datei bearbeiten

g Fabriten

Zu Baugruppe hinzufdgen

den betroffenen Knoten in der
Wiederverwendungsbibliothek zu

ﬁ aktualisieren.

A |+ ff SPLM_PTS Beispiele B
- 4§ HBBREUSE A—
: EF| Beicniele HRR

Aktualisieren I

Ausgangsordner offnen

A
+%0 A i'7 Favaoriten

{3} KRX-Datei erstellen/bearbeiten

Ausgabe

Ausgabedatei
CANX_SHARE\NX11'\Reuselibrary\Beispiele_HBB\O-Ring_mit_Abzugskoerpe @

Dateien

Tabellenkalkulation
W ool NE_Share/NX11/Reuselibrary/Beispiele HBB/O-Ring_mit_Abzugsko B2
Legendenabhildung
wf o o WK _Share/MNX11/Reuselibrary/Beispiele HBB/O-Ring.bmp

Familienelement-Speicherverzeichnis

Primé&re Parameter

Ri Parameter Beschreibender Ma...
DOring Ri Ri
¢ 4 1n | »

Automatische Ubereinstimmung
T | @ Machst groBte oder gleich (= =) ‘Ei
() Nachst kleinste oder gleich (<=)
() Gleiche GréBe wie(=)

Abbrechen
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Wird der O-Ring benutzt, so ist noch Folgendes zu beachten:

Das Vorschaubild (Legende, Legend) wurde mit einem
Screen-Capture-Programm ,geknipst‘. Es muss eine BMP-
Datei sein.

Die angebotenen Parameter entstammen einer Excel-Datei
(siehe unten).

Die mitgegebenen Zwangsbedingungen (Ermittelte
Zwangsbedingungen verwenden, Use Inferred Constraints)
sollen benutzt werden. Wie man diese mitgibt, finden Sie
weiter unten.

Damit die Tasche (Nut) gleich abgezogen wird, muss die
Option Tasche erzeugen (Create Pocket) aktiv sein.
Achtung! Damit Sie an dieser Stelle die Fehlermeldung
vermeiden, dass nichts abzuziehen ist, muss der O-Ring mit
der <MT1> direkt auf den Kdrper gezogen werden. Diese
,Landeflache” wird auch sofort automatisch fur die erste
Verknupfung genutzt.

\88\ D’ 1 Abstand messen

Einfacher Einfacher
Abstand  Winkel G Lokaler Radius

Messen

GO BR-&-G-wW-

|5 Winkel messen

¥

Weitere

Ausdricke

T 'Werkzeuge

fo} WiederverwendbzI:e Komponente hinz.. 3 X

Legende
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O Wiedens
MName
+§ Reusa
-;---éIZD Sec
% Faster
+-ffff SPLM,
+ﬁ SPLM.
+ff SPLM.
= i Hee £
+ i UDF-E
+ﬂ Benut
Primare Parameter A + ¥y Favori
Ri 20 -
Parameter M 3 I —
MName Wert Suchen
e Ri 20
£f* DOring 3
Elementau
= .
< i » &
Platzierung
(==
Ermittelte Zwangsbedingungen verwenden
O-Ring 5
Abtastpunkt ﬁgi
Mehrfach hinzufigen Kein -
Positionierung Mach Zwangsbhedingu =
Menge in jeder Operation
Tasche
Tasche erzeugen
Tasche bearbeiten BH
Referenz/Klon v
Einstellungen A
Mame O-RING_MIT_ABZUGSKC
I Reference Set anzeigen | Model("MODEL") - ]
Layer-Option Qriginal - Vorschau



Die Parameter konnen in einer Excel-Datei festgelegt bzw. mitgegeben werden.
Dabei wird die erste Zeile mit ,Parameters” bezeichnet und wenn die Tabelle abgeschlossen ist, steht ,END* in einer
Zelle der Spalte A.

Die verschiedenen Angebote der Spalte A (Parameter Ri = Ringdurchmesser) kdnnen spater ausgewahlt werden. Die
weiteren Spalten (B, C, D ... etc.), werden einfach zugeordnet.

A B In unserem Beispiel gibt es 3 Angebote fir 50er Ringe Primare Parameter

1 PARAMETERS (Gummistarke 4 - 6,5 und 10 mm). Wahlt man einen
7 | Ri DOring Ri =50 mm an, so verandert sich der NX-Dialog ein wenig Ri 30
3 20 3 und es gibt zusatzlich eine Auswahl fir die verschiedenen DOring 4
4 50 4 Gummistarken. -
5 50 6.5 Parameter 5
& a0 10 Name iﬂ
T 100 6 o5 Ri =
5 |END £f* DOring 4
Fehlt noch die Vorgehensweise, wie man vordefinierte st Semen ooy | 7 £ ¥ Banmbedongen st &
Zwangsbedingungen (Constraints) mitgibt, um das Einbauen -« Komponente [Eau ngsbedingunge| L C e anzeigen Exlasansansten Kolldonir
noch schneller und noch einfacher zu gestalten. e@H/  \AOO+, Gy MEOD-&-@0-

{3} Baugruppenzwangsbedingungen O X
Dazu wird der O-Ring ohne Zwangsbedingungen eingebaut. it "
Danach wird er von Hand sinnvoll zwangsbedingt. (Hier ,j ? - 1‘_ Z‘ e
wurden die ,Landeflache” und die Mittelachse mitgegeben.) :
Achtung! Dafiir ist es ggf. notig, auf den Ref. Set ,Ganzes e ]
Teil” (Eintire Part) zu schalten! * ZueiObjektecusmaien® 1] 4

Einstellungen A

Anordnungen Komponenteneigense

Dynamische Positionierung

Assoziativ

[F] Kurven und Routing-Objekte verschicben

Dynamische Aktualisierung der Routing-Volume
Aktivierte Zwangsbedingungen v

Abbrechen
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Die Zuordnung erfolgt nun Uber Zwangsbedingung speichern (Remember Constraints).

\ﬂ- Zwangsbedingungen anzeigen/ausblenden

I:.g,_m21.-'|.rar15;|s|::lE:l::Iir15;|l.|r15;|li:n speichern pLw

&= Freiheitsgrade anzeigen Explosionsan:

WLHIY {3 Gespeicherte Zwangsbedingungen D ¥

=y

¥ Komponente A
¥ Komponente auswahlen (0] -%
Zu speichernde Zwangsbedingungen A

+* Zwangsbedingungen auswihlen (0] .

%

Abbrechen

%+ Zwangsbedingungen anzeigen/ausblenden

:ﬁ_ﬁ Eemember Constraints 14

:,:;- show Degrees of Freedom Expl

Component Position

£} Remembered Constraints D X
Component A
¥ Select Comnponent (0] '%
Constraints to be Remembered M
¥ Select Constraints (0) .

Cancel

Die anschlielliende Auswahl der betroffenen Komponente ist wichtig, denn dieser Komponente werden diese
Zwangsbedingungen mitgegeben. Das Bibliotheksteil der Wiederverwendungsbibliothek wird also geandert!
Ein Schreibrecht auf das Part ist natiirlich vorausgesetzt!
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Die Zuordnung der gewunschten Zwangsbedingungen ist am besten Uber den Baugruppen-Navigator im Abschnitt
Constraints anzuwahlen. Dabei kdnnen ggf. vorhandene Zwangsbedingungen geléscht oder Uberschrieben werden.

£} Gespeicherte Zwangsbedingungen 9 8 [ Baugruppen-Navigator

Komponente M Beschreibender Teilename &
g T"DE’ Schnitte
& Komponente auswahlen (1) '% = -Ri ;
iA:fp O-Ring_mit Abzugkoerper_A...
—ﬂ Constraints
Zu speichernde Zwangsbedingungen A : E Y Ausrichten (O-RING_ML..
|- w Berih O-RING_MI...
& Zwangsbedingungen auswahlen (2] -$—J' ; = r.ung[ =
& - @ O-Ring_mit_Abzugskoerper

Gespeicherte Zwangsbedingungen entfernen X

Verwenden

““ Anwenden || Abbrechen |

Mit ,OK* erfolgt die Zuweisung.

Wenn Sie versuchen alle Parts zu schlieRen (Datei > SchlieRen > Alle Teile, File > Close > All Parts), dann kommt eine

Meldung ahnlich der hier abgebildeten.

Daran erkennt man, dass sich auch das Bibliotheks- o _ _ _

Part (hier: O-Ring_mit_Abzugskoerper.prt) andert, /_E Die Anderungen an fo_lgends;n Objekten wurden noch nicht gespeichert:

obwohl es nicht das Aktive Teil (Work Part) ist! &8  Vordem Beenden speichern!

Schreibrecht muss gegeben sein! O-Ring_mit_Abzugskoerper.prt
O-Ring_mit_Abzugkoerper_Anwendung_MNx11.prt

Ja - Speichern und Beenden | Mein - Beenden | | Abbrechen
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Letzte ,,Falle“:

Wenn Sie den O-Ring mit der Excel-Tabelle ein zweites Mal einbauen und andere Werte wie beim ersten
Mal benutzen, so andert sich auch der zuerst eingebaute O-Ring! Das ist bei vielen Teilen eher nicht
gewunschte. Damit Sie dieses Verhalten verhindern und unterschiedliche O-Ringe verbauen kdénnen,

Referenz/Klon M Reference/Clone M

Reference |@ {Clone!

Referenz | @ Klonen

Teilenamenverwaltung __-..-*"I- Part Marme Management AP

muss die Einstellung auf Klonen (Clone) geschaltet werden. Wenn Sie die O-Ring-Varianten nicht Gber
eine Excel-Tabelle steuern sondern als Teilefamilie (Part Family) aufbauen, wird diese ,Falle* auch
umgangen. In der Excel-Tabelle der Teilefamilie bekommt dann jede Variante einen eigenen Namen
(z.B. Ring_3).

A B C D

Allgemein ist noch zu sagen, dass die gesamte 1 |DB_PART_NO  OS_PART_NAME | DOring Ri
Vorgehensweise doch recht komplex ist und wir dabei 2 [Ring_1 Ring_1 3 20
einige Ungereimtheiten (NX-Bugs) entdeckt haben. 3 |Ring_2 Ring_2 4 20
4 |Ring_3 Ring_3 4 30
5 |Ring_4 Ring_4 5 20
& |Ring_5 Ring_5 5 30
7 |Ring_6 Ring_o 5 40
& |Ring_7 Ring_7 6 30
9 |Ring_8 Ring_& 10 80
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£} Teilefamilien (4
Spreadsheet Column (Tabellenspalte) A
Verfiigbare Spalten Kemponenten -

MName

< I *

Aktionen A
Ausgewdhlte Spalten

MName Typ

DB_PART_NO =t

OS5_PART_NAME B

DOring

Ri

Aktionen v
Tabelle Teilefamilie A

Tabellenkalkulation bearbeiten

Familie I6schen

Einstellungen v



